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1. Intended Use 

Medmont Studio is a powerful software package for controlling the 

Medmont range of medical instruments from your personal computer or 

laptop. Medmont Studio is a component of the following instruments: 

 Medmont Automated Perimeters (all models)  

 Medmont DV2000 Diagnostic Video Imaging 

 Medmont Corneal Topographers (all models) 

The extensibility of Medmont Studio means that its capabilities expand as 

you purchase new instruments and software, fully integrating into a single 

working environment. 

In addition to controlling the instruments, Medmont Studio provides 

additional Analysis Tools and Patient Management facilities. These include 

complete patient management functions out-of-the-box using Medmont’s 

own database, or optionally via a 3rd party Practice Management system. 

Check the Medmont web site for an up-to-date list of supported 3rd party 

systems. 

In a small practice Medmont Studio can be run from just one computer, 

managing both the patient database and controlling the instrument. This is 

called the standalone configuration. 

For larger practices, Medmont Studio contains powerful features for inter-

connecting multiple computers to centralise data-storage on one computer 

called the server. All other computers on the network are called clients. 

Medmont instruments may be connected to any client in the network. 

This document describes the basic Medmont Studio capabilities, including 

patient management. Separate on-line and printed documentation is available 

describing the additional functionality specific to particular instruments. 

The software is not to be used for purposes other than stated in this manual. 

Software Conventions 

When referring to menu selection, the terminology Home > Patient > New 

means click on the Home ribbon bar tab, then look for the Patient group on 

the ribbon bar and click on the New icon. This format conforms to the Tab > 

Group > Action system for identifying menu items in a ribbon bar menu 

system. 
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A small glossary is included for terminology that originated with Medmont. 

It also includes some common terms where they apply to Medmont 

equipment. It is not a glossary of perimetry. Terms that appear in the glossary 

are underlined in the text. 

Explanation of Symbols 

 

Warning - In event of user error or equipment fault condition 

there may be a serious risk to health or life of patients or 

operator or product damage may occur. 

 

Note - notice that additional attention should be paid to use or 

maintenance to prevent misuse or unexpected behaviour 

Accessories 

 - PC incl. Operating system  (provided by customer) 

 - User Manual 

 - Isolation Transformer    (optional) 

 - Dummy plug network connection  (optional) 

 - Dummy plug serial 9 pin serial port  (optional) 

 - Label for Patient environment   (optional) 

Tab 

Action Group 



 Hardware Configuration 

 

 

 Medmont Studio User Manual 3 
 

2. Hardware Configuration 

Important: Install the software before inserting or attaching 

any new hardware to your computer. This allows the software to 

pre-install the hardware drivers ready for when the hardware is 

connected. 

PC and Associated Equipment Requirements 

Check that your computer meets or exceeds the very basic requirements 

listed below to run Medmont Studio. 

 Pentium™ processor-based personal computer, P4 2.8 GHz or Higher 

(P4 1GHz minimum). Motherboard using genuine Intel™ PCI chipset 

highly recommended. VIA chipsets have proven to be unreliable. 

 Microsoft™ Windows™ 7 and Microsoft™ Windows™ 8 

 3 GB RAM or more (2 GB minimum)  

 Video cards that share main memory are not recommended. For stereo 

viewing using shutter glasses, a compatible NVidia video card is 

required. 

 10GB of available hard-disk space setup to use NT File System 

(NTFS). 

 

Use only PC and associated equipment that has been 

certified to the Standard EN/IEC60950 (Information 

Technology Equipment) and the Standards for 

Electromagnetic Emissions CISPR22/EN55022. 

 

If used within a patient environment, power the PC and 

associated equipment with an EN/IEC60601-1 compliant 

isolation transformer e.g. Medmont TR2450 (230/240V), 

or an additional fixed protective earth connection. 

 

Cover any open PC communication ports that have 

accessible conductors with dummy plugs if used in a 

patient environment. 

 

If you have a previously installed version of Medmont Studio we strongly 

recommend that you back-up your old database before proceeding. 
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If you have used the archiving facility of the very old versions of Medmont 

Studio, you should un-archive old exams to allow the installation data 

conversion program to upgrade your data. The later versions do not support 

archiving. 
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3. Installation Configurations 

There are a number of configurations for a Medmont Studio installation that 

depend on the practice patient management environment and whether a 

networked computer system exists. Medmont Studio can be run in three 

configurations: 

 Standalone – A small practice configuration consisting of only one 

computer or alternately a small network system. The latter would have a 

computer for instrument control and another for administration where 

the patient data resides, and typically including a 3rd party Practice 

Management package. 

 Network (Client/Server) - For large practices with a local area 

computer network (LAN) in place. 

 Single User Review - An analysis-only mode is available that allows 

editing and analysis, but no capture from instruments. 

Standalone 

The standalone configuration is the most popular and simplest to use. 

Appropriate licensing for this configuration is included with each Medmont 

instrument. This is a versatile configuration that can be configured in a 

number of ways. 

Warning! Networking of the instrument computer with other computers may 

cause unacceptable leakage currents. Only connect through wireless network 

connections. 

A standard configuration consists of   

 A computer including monitor. 

 One or more Medmont instruments. 

 The Medmont Studio software. 

 Optional supported 3rd party practice management software same 

computer 

 Printer (wireless unless connected through isolation transformer) 

Another common configuration consists of 

 Two computers. One configured to control the Medmont instrument(s), 

and the other configured with one of the supported 3rd party Practice 

Management packages, the two typically connected as a Windows 

Workgroup through a wireless network connection. 
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 One or more Medmont instruments. 

 The Medmont Studio software. 

Both systems would also include: 

 An activation key with licenses for 

Exactly one session. 

Instrument license(s). 

Additional functionality licenses. 

Configuration Typical Use 

 Conducting exams. 

 Subsequent review, editing, and analysis of exams. 

 Patient management. 

Network (Client / Server) 

The Medmont network configuration works with one or more Medmont 

client computers connected to a single Medmont server computer. The 

underlying network can be either a Workgroup or a Domain based system. 

This configuration requires the purchase of a license upgrade from Medmont 

to allow multiple computers to run the software simultaneously.  

 

Warning! Networking of the instrument computer with 

other computers may cause unacceptable leakage currents. 

Only connect through wireless network connections. 

Where the Medmont Studio server software is installed depends on the 

operating system running on the network’s server computer. The options are: 

 The Medmont Studio server installed on the network server computer 

itself, as long as the server is running Windows Server 2003 or 

Windows Small Business Server 2003 or later versions of these 

products, or 

 The Medmont Studio server installed on one of the client computers in 

the network. 

The computer on which Medmont Studio is configured as a server requires: 

 An activation key with licenses for 

Maximum number of sessions (typically more than one). 

Instrument license(s). 

Additional functionality licenses. 
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 3rd party Practice Management software with software license as 

required (optional). 

One or more Medmont client computers with: 

 Medmont Studio software configured as a client. 

 Medmont instruments as required, although a computer can be a 

Medmont client without having an instrument connected. 

Configuration Typical Use 

 Administration - Provides centralized functionality for large practices 

One shared database. 

One practice management system. 

Central maintenance of licensing. 

 Testing - Exams are conducted from any client computer with an 

instrument attached. 

 Review - Any computer in the network can act as a review machine, 

including the server. 

Single User Review 

The unlicensed mode is available when no license has been successfully 

authenticated. This mode replaces the now obsolete Medmont Studio Viewer. 

The physical configuration consists of   

 A computer. 

 Medmont Studio software. 

Configuration Typical Use 

 Review – For a small numbers of exams on a laptop or home PC. Data 

is transferred from the licensed system using the import/export 

facilities. 

 Referral to specialists - By a specialist (non-Medmont user) who is 

sent exam data by a practitioner using a Medmont instrument. 

 Presentation - When giving talks using a laptop and data projector. 

 Spread the word - Give a copy of the Medmont Studio CD to a 

colleague to try before they buy. 
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4. Installing the Software 

Medmont Studio is provided on a single USB flash drive that contains all the 

necessary software. To install Medmont Studio from the USB flash drive 

follow these steps: 

1. Insert the Medmont Studio USB software key into your computer. 

After a few seconds a Windows Explorer window will display. If 

not, launch Windows Explorer and select the new removable drive 

now listed in the left pane labelled “MEDMONT”.  

2. Next, expand the removable drive and select folder “Medmont 

Studio”. Double-click on file setup.exe to start installing the 

software.   

Common Installation Steps 

Medmont Studio requires the installation of the Microsoft .Net (pronounced 

dotNet) Framework. 

If the Microsoft .Net Framework was previously installed, or if your 

operating system has this package preloaded, then the Medmont Studio will 

skip the installation of this software package. Otherwise, click Accept to 

install the Microsoft .Net Framework 

 

Figure 1. .NET Framework Accept screen. 
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The next dialog will show the progress of the .Net installation (if required). 

Note that if you select cancel at any stage, then the installation of Medmont 

Studio will not proceed any further. 

Once the software packages are installed, click Next to start the Medmont 

Studio installation wizard.  

 

Figure 2. The Medmont Studio Setup Wizard. 

The next dialog allows you to define where the associated files will be 

stored. Medmont strongly recommend that you leave the chosen default 

path. Click Next to proceed.  

 

Figure 3. Installation folder selector. 
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Note: This step does not decide the location of your patient 

database. This will be assigned later in the configuration step. 

This is the location of the application files only. 

Next, the dialog asks you to confirm that the installation can begin. Click 

Back if you need to review or change any of the previous options. 

Otherwise, click the Install button and the installation will proceed. At this 

point the setup process displays a dialog with a progress bar to visualise the 

file copying process.  

 

Figure 4. Installation confirmation. 

With all files transferred, the Medmont Studio Configuration Tool will run 

and asks you to select from the set of Medmont Studio language translations. 

The Medmont Configuration tool presents the next series of 

system configuration dialogs. When the installation is complete, 

this can be run to re-configure the system at any time from: 
Start > Programs > Medmont > Medmont Studio Configuration 

Tool 

Once the language is selected the next dialog asks you to select the type of 

Medmont Studio installation. 

Installing a Standalone System 

Click on the Standalone radio button and then on the Next button. 
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Figure 5. Executing mode selection. 

The next page of the wizard will ask you what database operation you would 

like to perform. Once selected click on the Next button and the wizard will 

guide you through the steps of obtaining all of the relevant information to 

complete that process.  

 

Figure 6. List of database operations 

Upgrade a version 3 database 

You will need to provide the location of the version 3 database files and a 

new location to store your new database. These locations cannot be the same. 

Currently Medmont Studio only supports upgrading a version 3 database to 

an Access database. Once this conversion is complete you can re-run the 

configuration tool to convert it to SQL Server® or move it to another 

location if desired. 



Installing the Software  

 

 

12 Medmont Studio User Manual  
 

Upgrade a version 4 or 5 database 

You will need to provide the location of the version 4/5 database that you 

would like to convert as well as the type of database that is being upgraded 

(Access® or SQL Server®). Version 4/5 upgrades are performed in place 

and must use the same database type as used previously.  Once this 

conversion is complete you can re-run the configuration tool to convert the 

type of database or move it to another location. 

Create a new database 

This operation will create a new, empty database. You will need to provide 

an empty folder to install the database to and if you are using SQL Server® 

you will also need to provide the server location and login credentials.  

Use an existing version 6 database 

If you have successfully run the configuration process before then this will 

be the default option. If you select this option and have run the configuration 

process before then the next step will show the path to the previously chosen 

database, if you would like to change to a different database then press the 

Location button and chose a different database path.  

Move existing version 6 database 

This option will allow you to move the currently configured database to a 

new location on the current PC. The destination folder for the database must 

be empty and please remember when changing your database folder you may 

need to update any automated backup applications you are using to protect 

your data. 

If you are using an SQL Server® database this option will also allow you to 

move the data to a new server providing you have the relevant login 

credentials.  

Convert database to Microsoft SQL Server® / Access® 

This option will allow you to perform an in-place change of the type of 

database you are currently using. When changing to the SQL Server® 

technology, as well as requiring valid user credentials you will also need to 

provide a unique database name. You cannot specify a database name that 

already exists on the server.  

Once you have entered all the required database information, the installation 

needs to know whether you are integrating Medmont Studio with a 3rd party 
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practice management system. This option seamlessly integrates the patient 

management of both systems (see Installing with a 3rd Party Practice 

Management System on page 19). We will continue with the None option 

here. Click the Next button to continue. 

  

Figure 7. Option to select PMI. 

An installation typically consists of one or more Medmont instruments. The 

next dialog allows you to select which instruments to install. Installing 

instruments for which you do not have a license will use additional computer 

resources, but nevertheless does offer a review capability where you can 

view results produced by those instruments on other computers or from other 

practices. 

  

Figure 8. Instrument selection dialog. 
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The next dialog is associated with installing the Windows Drivers for M700 

instrument features and the various digital image frame grabbers associated 

with the DV2000 and E300 instruments.  

Complete the installation of Medmont Studio before connecting 

or installing the associated hardware for the first time. 

Some of these selections may be greyed-out depending on the instruments 

that were previously selected for installation. Select the drivers associated 

with your instrument(s). 

  

Figure 9. Windows Driver installation dialog. 

Clicking the Next button will proceed to the final step of the installation. You 

now have an option to review your previous steps or cancel the setup. Click 

Back to change any of the previously selected options or click Cancel to 

stop the setup of your software. 

Otherwise, click Finish to finalise the installation. Once this process 

completes, and depending on the selected instruments and existing installed 

Windows Drivers, a number of device driver installers will automatically 

run. Simply follow the prompts and click on the OK button. If previously 

configured, the database conversion from another version of Medmont 

Studio will also happen at the end of the installation process. 
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Figure 10. Installation complete screen. 

The Medmont Studio icon  will now appear on the Windows desktop. 

Additionally, you can also launch Medmont Studio, Medmont Studio 

Administrator Tools and Medmont Studio Configuration Tools from 

Start > Programs > Medmont. 

Installing a Server Based System 

A server based system consists of a computer with Medmont Studio installed 

as a database server, and one or more additional computers with Medmont 

Studio installed as clients, all connected with a standard Windows network. 

The server is configured to manage the patient database.  

Installing the Server 

Install the software as per the previous instructions until you are prompted 

for a Standalone, Server or Client installation. Click on the Server radio 

button and then the Next button. 
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Figure 11. Selecting a Server installation. 

If you have more than one network connection available in your server 

computer, the next step of the wizard will ask you which network interface 

you would like to use to connect to your client PC’s. This will be the 

network card that is connected to your local network and thus, your client 

PC’s.  

The installation will proceed from this point exactly the same as the stand-

alone installation. When the installation completes the server starts 

automatically and you should see the Medmont Studio server icon  in the 

Windows desktop tray. 

Installed Medmont Studio clients can now connect to the server. However 

there are a number of steps required to license the server and these are 

covered in Running Medmont Studio starting on page 21. 

Installing the Clients 

The server installation must be completed, configured, and running on the 

designated server computer before attempting to install any clients. 

Install the software as per the previous instructions until you are prompted 

for a Stand-Alone, Server or Client installation. Click on the Client radio 

button to select a client computer installation as shown in Figure 12. 
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Figure 12. Selecting a Client installation. 

The next dialog will present a drop-down list with the names of the 

computers in your network. Select the computer on which the Medmont 

Studio server is running, then click Next. 

  

Figure 13. Selecting a server. 

The next dialog will ask for the instruments attached to this client computer 

(see Figure 14). Based on your current license, select the appropriate 

instruments to be installed and click Next. 

The next step will allow you to install Windows drivers for the appropriate 

instruments. Some of these selections may be greyed-out depending on the 
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instruments that were previously selected for installation. Select the drivers 

associated with your instrument(s) and click Next. 

 

Figure 14. Final installation dialog. 

Review your previous configuration by clicking Back if needed. Otherwise, 

click the Finish button to complete the setup. 

 

Figure 15. Installation complete screen. 

Lastly, if the setup will only be used for exam review, then the installation is 

complete. Double click the Medmont icon on the desktop to start Medmont 

Studio. Check that the Practice database is visible and that patient and exam 
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details are also visible. Whether these can be edited or changed will depend 

on the permissions given to the particular clinician (see Setting Permissions 

on page 25). 

If the computer will have an instrument attached then use the procedure 

described in the Installation section of the relevant instrument User Manual. 

Installing with a 3rd Party Practice Management System 

You can integrate a 3rd party Practice Management System with Medmont 

Studio. The option to create a Patient Management Integration (PMI) system 

is presented during both a Stand-alone and a Server installation. 

 

Figure 16. Option to select PMI. 

When prompted by the configuration tool, select your Patient Management 

system from the drop-down selection box. The list of supported Patient 

Management systems will be updated when a new system receives 

integration support. Please check http://www.medmont.com.au for an up-to-

date list. 

Click the Next button and you will be asked for the location of the PMI data 

files.  

http://www.medmont.com.au/
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Figure 17. Selecting the path to a 3rd Party Patient management system. 

Click the Location button to make any changes to the default if required. 

When you click the Next button the install program will examine the entered 

location for the expected set of files. If they exist the installation will 

proceed as previous. 
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5. Running Medmont Studio 

Double-click the Medmont Studio icon on your Windows desktop. 

 

A banner with the Medmont Studio logo is displayed while the software 

loads.  

For the First Time 

The first time you run the software after installation you will be prompted to 

install a license as shown in Figure 18. 

 

Figure 18. License prompt. 

To install a license select the License Medmont Studio now option which 

will display the License Manger window, please follow the section Installing 

a Medmont Studio license. If on the other-hand you would prefer to run 

without a license (not connected with an instrument) then you can choose to 

run as a review station by selecting the Skip licensing now option. Selecting 

skip will prompt you again next time you run the software. 

Next you will be asked to register your Medmont Studio software. 

 

Click No if you do not want to register your software now.  
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Please note that you will be prompted to register each time your 

software starts until you have successfully registered. 

If you click Yes, the registration window will be displayed as per Figure 19.  

Registering your software 

You can register your software at any time by clicking on the Help > 

Register menu. Once selected the Registration window shall be displayed as 

per Figure 19. 

 

Figure 19. Software registration window. 

Before proceeding with the registration process please ensure your computer 

has a working internet connection. If running in a client/server mode the 

registration only needs to be performed once and can be done from any 

client computer.  

Enter information into all of the available fields. The fields marked with a 

red asterisk are required fields and must be completed before proceeding. 

Once all information is entered click on the Register Now button. If the 

registration process is successful the following message shall be displayed. 

 

If a different message is displayed please check your internet connection and 

try again, if the problem persists please contact your local authorised 

distributor for support. You can update your contact details at any time by 
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opening the Registration Window by clicking Help > Register and clicking 

on the Change button, modify your details and press Register Now again. 

You are now ready to start using Medmont Studio. 



Configuring a Server/Client System  

 

 

24 Medmont Studio User Manual  
 

6. Configuring a Server/Client System 

A standalone Medmont Studio system is ready-to-go once the installation 

completes. However a Server/Client installation will require some additional 

configuration. 

Setup for a Secure System 

By default a system installed with a server and several clients will be an 

insecure system. This means anybody can use Medmont Studio and have full 

administrator privileges. 

This may be an adequate configuration in a small practice. However, in a 

large practice with many clinicians, or in a teaching environment, the 

recommendation is for a password-protected system. This allows the system 

administrator some control over the access each clinician has to the 

Medmont Studio capabilities. For example, a clinician (or more correctly, a 

particular password) can be prevented from deleting patients, or from 

(re-)configuring instruments. In a teaching situation, students can be issued 

with a generic password that only allows for creating patients and 

performing tests. 

Password protection can be useful even for a small practice, where the 

system is normally accessed via a password that allows everything except 

patient deletion. For this case the clinician must log back in using the admin 

password. This action therefore requires a specific step, and helps to prevent 

inadvertent deletions. 

Setting the Administrator Password 

The first step is to setup the administrator password. With Medmont Studio 

running click Configure > Logon > Set Password. It will present the login 

dialog shown here. 

 

Figure 20 – Set Password Dialog 
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Fill in and confirm the password you will use to administer the networked 

Medmont Studio system. The name “admin” has by default all the 

permissions shown in Figure 22. 

Adding Clinicians 

The next step is to register the clinicians who will be using the system. Click 

on Configure >Studio > Clinicians to display the Clinicians dialog shown 

in Figure 21 

 

Figure 21. Manage the Clinicians in the Practice dialog. 

Click the New button in this dialog to display the New Clinician dialog 

shown in Figure 22. Fill in the text boxes in the Details section. By default 

this clinician will be enabled to use the system with the Enable Logon 

checkbox ticked. Enter the name the clinician will use to log on to Medmont 

Studio into the Logon text box. Click the Set Password button and enter 

their password. 

Setting Permissions 

If you tick the Administrator checkbox that clinician will have access to all 

the listed options. 

If you click nothing then that clinician will be able to review results only. 

Tick the other options as your situation requires. 
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Figure 22. Enter and Edit the New Clinicians dialog. 

You can prevent a user from logging on by un-checking the Enable Logon 

checkbox if necessary. 

Database management 

A separate program to Medmont Studio performs database management.  

 

Click on Start > Programs > Medmont > Medmont Studio 

Administrator Tool. The Data Management tab on this dialog provides the 

path to and size of the Medmont Studio database. Prior to running a system 

backup (see Data Backup on page 98) execute the steps listed on this dialog. 

The Passwords tab has a single button that will clear the Medmont Studio 

administrator password. 
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Session Management 

A client logged on to the system constitutes a Session (see also Session 

Licenses on page 88). You can review the current sessions at any time by 

clicking the Configure > Studio > Sessions menu entry. 

 

Figure 23. Medmont Studio Session Manager. 

The administrator can kill a session at any time by selecting the entry and 

clicking the Kill Session button. This does not literally kill the Medmont 

Studio application on the client computer, but just disconnects it from the 

database.  

If the session is in use there is a strong possibility of data loss 

for that session. 

Database Locks 

When a client computer accesses the database by examining a patient’s 

details or by viewing an exam, there is nothing stopping another client 

computer examining that same patient or exam. However, as soon as one 

client attempts to edit patient details or start annotating an exam, that entry 

in the database will be locked. Because an editing session may consist of 

several edits, the item will remain locked until it is dismissed, typically by 

the clinician saving it or by moving on to the next patient or exam.  

While an entry is locked, if another client attempts to change the same entry, 

they are immediately presented with a message indicating that someone else 

has that entry locked. 

As an example, if a clinician on client computer A is adding comments to a 

particular patient’s record, and a clinician on client computer B also attempts 

to add some comments to the same patient record, client B will be presented 
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with a warning message about the record being locked the instant typing 

starts. In effect he or she will be prevented from typing anything at all.  

As soon as client A moves on, the lock will be removed. At this point if 

client B tries once more to add his or her comments, at the instant typing 

starts a message will be presented stating that another user has changed this 

record. Clicking OK on the message will update the client B display, 

showing the changes made by client A. Client B can now see these new 

comments as well as being free to start entering further comments. 

Clicking on the Locks tab in the Session Manager dialog shown in Figure 23 

will show the current set of database locks. 

Client Caching 

Practice’s that are interconnected over low speed connections can benefit by 

enabling the client caching option. Enabling client caching improves 

performance by storing exam data locally and transferring the exam data to 

the server in the background. This means the user is free to continue normal 

operations rather than wait while the exam data is transferred to the server 

which could take several seconds or minutes on very low speed networks. 

The exam data is available immediately on the client where the data was 

captured but may not be available at other clients until the background data 

synchronization is complete. 

To enable Client Caching run the Configuration Tool and tick the check box 

labelled Enable Client Caching (for remote servers) located within the 

server settings tab. This option is only available when configuring a client 

setup. 
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7. Practice Management System Integration 

When Medmont Studio is operating with Practice Management Integration 

(PMI) activated, it smoothly integrates the patient management of a 3rd party 

Patient Management system with its own Patient management. Medmont 

Studio uses the 3rd party system only as a source of patient data - it cannot 

change the data in any way.  

An additional license is required to connect Medmont Studio to a 3rd party 

Practice Management system. 

Patients who are listed in Medmont Studio are those for whom an 

examination has been performed using a Medmont instrument. A new 

Medmont Studio installation will therefore have no patients listed even 

though the PMI may have hundreds.  

While you can still create patients with Medmont Studio by clicking on the 

 Create New Patient icon, they will be unknown to the PMI.  

Adding a New Patient in Medmont Studio 

The idea is to link Medmont Studio to a patient entry in the PMI. The 

technique is to use the Find Patient menu entry when starting a new exam. 

This displays the Find Patient dialog, which for a PMI system is directly 

linked to the 3rd Party Patient Management system database. 

 

Figure 24. Find a Patient in 3rd party Management System. 

Figure 24 shows the range of selection options for a patient search. At this 

point it is more than likely you will have the PMI application open prior to 
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starting Medmont Studio as part of your initial patient interview. This 

implies the patient either already existed there or you have just entered the 

details for a new patient. Now use the Find Patient dialog to copy the patient 

details to Medmont Studio. 

The quickest method is to copy the 3rd party Management System patient ID 

number into the Medmont Studio External ID field and click the Search 

button. This will produce a guaranteed singular match. Click OK to create a 

matching patient entry in Medmont Studio. 

The alternative is to enter some search criteria into one or more of the text 

boxes. In Figure 24 the clinician has entered B* in the last name box and 

then clicked the Search button. This will search for all names in the PMI that 

start with “B”, as the asterisk is shorthand for “match anything” (see 

Searching by Patient Name on page 45). The search example located three 

patients. Select the correct one and click OK to create a matching patient 

entry in Medmont Studio. 

Synchronising the Databases 

If for some reason a patient has been entered into Medmont Studio without 

being linked to the PMI, you can reconcile the entry at some later time.  

First select the patient in Medmont Studio and on the Home tab, click on 

Synchronise Current. If the details previously entered into Studio match 

those in the PMI, this will reconcile the two entries, automatically adding the 

PMI external ID to the Medmont database. The ID will now be visible in the 

patient details External Record box.  

What if there is no matching entry in the PMI database? As an example, 

suppose someone had previously entered a patient called Peter Adams with a 

birth date of 14-5-1956 and proceeded with some exams but without linking 

to the PMI. Perhaps the network was down. At some later time it is noticed 

this patient has no external ID number. Select this patient and on the Home 

tab, click on Synchronise Current. Medmont Studio displays the dialog in 

Figure 25, indicating no matching entry in the PMI.  
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Figure 25. Example No Patient Match in PMI dialog. 

The next step is to check if there is such a patient as Peter Adams in the PMI. 

On the Home tab, click on Find, entering this name and then clicking the 

Search button shows the dialog of Figure 26.  

 

Figure 26. Example search PMI database. 

The dialog shows that there is such a person, but that the birth date is 14-12-

1956 rather than the 14-5-1956 entry in the Medmont Studio database. Re-

doing the Synchronise Current sequence and clicking on the Clear button 

for the Date of Birth entry will remove that criterion. Now clicking on the 
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Search button will find this patient and clicking OK will update the 

Medmont Studio database with a complete entry. 

 

Figure 27. Example patient found dialog. 
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8. Overview 

The User Interface 

Medmont Studio has a single main Windows Explorer style user-interface, 

and provides point-and-click access to its capabilities. The user can swap 

between instruments and most tasks with a single mouse click. 

 

Figure 28. Studio Main Window. 

The main window shown in Figure 28 is divided into three areas:  

Explorer pane: Lists patients and exams. These can be selected by 

single mouse click. Filtering, sorting and searching are also supported. 

View pane: Displays the current patient or exam(s) selected in the 

Explorer pane. 

Ribbon: Tabs to select a function with a single mouse click. Examples 

are entering a new patient or creating, analysing and editing an exam. 

These are described in detail in subsequent sections. 

Ribbon bar 

Explorer 

pane 
View pane 
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9. The Explorer Pane 

The Explorer pane allows you to select the data you wish to display. The 

Patients pane (Figure 29) displays patients within the Medmont database as 

top level elements, with exams for each patient displayed under them. 

 

Figure 29. Explorer pane showing the Patients pane 

The Exams pane (Figure 30) shows exams within the Medmont database as 

top level elements and allows you to sort, filter and select exams across all 

patients.   

 

Figure 30. Explorer pane showing Exams  

You can select either of these views by clicking on the respective selection 

tab along the bottom of the Explorer pane as shown below. Additional tabs 

for specific instruments may also be present depending on the installed 

components.  The data displayed within the Patient and Exam tabs depends 

on the width of the Explorer pane. Expanding the explorer pane (by dragging 

Exams 

tab 
Splitter bar 
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the splitter bar) displays additional information in columns which can be 

sorted and arranged. 

Sample Data 

If this is the first time you have used Medmont Studio, you can become 

familiar with most aspects described in this and the instrument manuals by 

importing the various sample data sets on the flash drive. There is sample 

data for the M700, E300 and DV2000 instruments and a corresponding set of 

patients. 

Click on the File menu, then click Import and navigate to the Sample Data 

folder on the flash drive. You can import any or all of the files (although only 

one at a time). 

Changing the Size and Position of the Explorer Pane 

A vertical splitter bar separates the Explorer pane from the View pane (see 

Figure 30). The size of the Explorer pane can be changed by dragging the 

splitter bar to the left or right. The View pane rescales itself correspondingly.  

Both the Patient and Exam tabs automatically reformat the displayed data 

when more space is available to display data in columns which can be sorted 

and arranged. 

A horizontal scroll bar will appear along the bottom edge of either pane if 

required. 

Docking and Undocking 

Double clicking on the title bar of the Explorer pane undocks the Explorer 

pane turning it into a free-floating window. This creates maximum space for 

the View pane. If your system has dual monitors, dragging the Explorer pane 

to the other monitor leaves the View pane full-screen. 

Double clicking the title bar again re-docks the Explorer pane in its usual 

spot (left of the View pane). 

Unpinning and Pinning 

Clicking on the Explorer pane vertical drawing-pin icon (see Figure 31) 

unpins the pane. The pin will change to a pin lying on its side and the pane 

will slide off screen to the left of the main window and auto-hide itself when 

not in use. The pane appears as a thin vertical strip containing the same set of 

filter icons as were across the bottom of the expanded pane. 
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Figure 31. Explorer pane docking pin location. 

When the Explorer pane is unpinned, a single click on the desired tab will 

temporarily expand the Explorer pane. Any one of the selection tabs can be 

selected by hovering the mouse cursor over the tab for a short period - no 

click is required. 

Clicking on the horizontal pin turns off auto-hide. 

Patients Explorer Pane 

The patient’s pane lists all patients known to the system in alphabetical order 

(by default). An icon represents the patient’s gender.  

If the patient has exams stored on the system a small  symbol will be 

visible to the left of their name. Clicking on this symbol will show the exams 

for that patient, and the symbol will change to a  symbol. Clicking on this 

symbol will hide the exams again and restore the original  symbol.  

The same symbol will appear for some types of exam that have associated 

sub-items. 

The Patient’s Pane can be expanded (see Figure 32) to show a tabular list of 

the patients and their exams. The width of the columns can be adjusted by 

clicking on the vertical line separating adjacent column headings and 

dragging left or right.  Columns can be added or removed by right clicking 

on the column header area and selecting Show/Hide 

columns. Columns can moved and reordered by clicking 

on the column header and dragging. 
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Figure 32. Studio Main Window showing the expanded Patient View. 

Exams Explorer Pane 

The exams pane lists all exams in the database in exam date order (by 

default).  Like the Patients Pane it can be expanded to show a tabular list of 

the exams and their attributes. The width of the columns can be adjusted by 

clicking on the vertical line separating adjacent column headings and 

dragging left or right.  Columns can be moved and reordered by clicking on 

the column header and dragging.  Columns can be added or removed by 

right clicking on the column header area and selecting Show/Hide columns.   

The displayed/available columns depends on the currently selected item.   

Only columns relevant to the currently selected item are displayed. 

Adding a Patient 

From the Medmont Studio main window, click on Home > Patient > New to 

bring up the New Patient dialog shown in Figure 33. 
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Figure 33. New Patient dialog. 

Text entry boxes in Medmont Studio such as Last Name and First Name in 

Figure 33 use Auto Case by default. For details of how this effects entering 

patient details, see Auto-Capitalisation on page 82. 

The General tab provides for entering a standard set of patient identification 

parameters such as Name, Date of Birth, Gender, etc. The External Record 

entry can be used to link the patient to a 3rd party patient management 

system. 

The Clinical tab dialog shown in Figure 34 provides for selecting clinical 

details that describe the patient’s condition. The Current Refraction entries 

provide for recording a current prescription and are quite straightforward. 

You can enter numbers directly or by using the up/down spin buttons. 
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Figure 34. New Patient Clinical tab. 

The three drop-down boxes display selections from your practice set of 

categories as entered into the Configure > Studio > Lookup Fields option, 

as shown in Figure 35. Use the Custom Fields dialog to enter Procedure, 

Condition and Category descriptions (both patient and exam) that apply in 

your practice. Note that you cannot make new entries in the Clinical tab from 

the New Patient dialog; they must be entered from the Custom Fields dialog. 

The Comments tab of the New Patient dialog presents a simple text-editing 

window into which you can enter any relevant details. Once comments have 

been entered an indicator icon  shall appear in the title for the comments 

tab. 

 

Figure 35. Custom Fields Entry and Editing dialog. 
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The Refresh Button 

The Refresh button in Figure 35 and other dialogs in Medmont Studio 

software only have a real function in a networked system. In these systems, 

clicking the button will update the items associated with the current dialog 

from the central database. Thus if items have been edited on one client 

computer, they can be updated on any other client computer by clicking the 

Refresh button in the relevant dialog.  

Editing a Patient 

If you click on an existing patient you will see the same dialog shown in 

Figure 33, only now the title bar will show the selected patient’s name and 

the various fields will be filled with data. You can use the dialog to review 

the patient’s details or make any changes that may be required. 

Selecting Explorer Pane Items 

To select a single item in the Explorer pane, such as a name, click on the 

symbol or the label to the right of the symbol (in the tree) or anywhere on 

the line (in other views). The selected item will be highlighted and the View 

pane will show data or an image for that item. Figure 36 shows a patient 

with the exams shown, a particular exam selected (shown highlighted), and 

with that exam displayed in the View pane. 
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Figure 36. Selecting and displaying an item from the Patient Explorer pane. 

Selecting Multiple Items 

To select multiple items, hold down the control key while selecting 

additional items.  

To select a range of items, select the first item in the range and then select 

the last item in the range while holding down the shift key or simply drag the 

mouse while holding the left button down, over the items you wish to select. 

Procedures, Conditions and Categories 

Procedures, conditions and categories are custom fields that allow you to 

categorize and filter patients and exams.   You typically set these fields for a 

patient or exam using the Details View (see page 58).    The selected custom 

fields are, by default, displayed in the second entry line in the explorer pane.  

You can control this in the Explorer Pane user settings by clicking 

Configure > Studio > Preferences.  The text (and its colour) displayed in 

the explorer pane for a custom field can be changed by editing the field 

using the Configure > Studio > Custom Fields.  

The explorer pane also provides a short cut mechanism for setting custom 

fields for the selected item.   Use the right mouse button to select an item in 

the Explorer pane.   Select or deselect the Condition, Procedure or Category 
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to associate with the item.   Note that Conditions and Procedures only apply 

to patients. 

Filtering 

The Patient View provides three filter modes:  All, One and Filter. These are 

selected from the dropdown list just 

above the tabs at the bottom of the 

Explorer pane. The message 

“xx found” beside the selector, 

indicates how many matching 

patients can be seen using the current filter. 

The selections are: 

 All - shows all the patients in the system. 

 One - shows the currently selected patient. This is especially useful 

where privacy is a concern, for example when showing a patient her or 

his exam; it will prevent that patient seeing a list of your other patients. 

 Filter - pops up a custom filter that allows the user to specify more 

detailed criteria. 

Selecting the Filter option will display the dialog of Figure 37 that 

demonstrates the very extensive patient filtering capabilities of Medmont 

Studio. As a simple example, with this dialog displayed, click on the Female 

radio button and then the Apply button. You should see the Explorer pane re-

display with just the female patients. 
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Figure 37. Patient Filter selection dialog. 

The Standard tab provides functionality for selection based on a number of 

standard selection criteria. The Advanced tab however, provides for 

considerably more detailed selection. The initial dialog is shown in 

Figure 38. 

 

Figure 38. Advanced Filter dialog. 

You may create a number of conditions via the New condition button, and 

the resulting selection will be based on each and every one being true if you 

leave the default AND radio button selected. Otherwise only one of the 

conditions need be true if you select the OR button.  
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Click on the New button to define a new simple condition. 

 

Figure 39. Advanced Filter Simple Condition entry dialog. 

The Simple Condition dialog shown in Figure 39 provides for selecting a 

field variable and equating it in some way with a value or perhaps with 

another field. A field in the Medmont Studio condition context is a patient or 

exam attribute. A Patient attribute would be age, name, gender, etc, while 

Exam attributes are items like an M700 threshold exam false positive count 

or an E300 exam iris area.  

The drop-down Field box allows for selection of the particular attribute. The 

drop-down Operation box provides for selecting from the criteria list, and 

the Value drop-down box provides for selecting a comparison value. 

Note that this dialog can extend the width of the Field drop-down box by 

clicking and dragging the left or right edge. 

Taken together, the set of simple conditions and whether they are ANDed or 

ORed provides for very powerful analysis of your patients and their exam 

results. 

Searching 

The Patient view has a search box at the top of the pane. It normally reflects 

the current patient selection. 
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Figure 40. Patient name Search box. 

Searching by Patient Name 

Type the last-name or a combination last-name, first-name to search for a 

particular patient. If a unique match is found that patient will be selected. 

Otherwise the Find Patient dialog will appear and you can use this to find 

the patient. The dialog will also appear where the search criteria is not 

sufficiently unique, such as entering “mi” when the patient database includes 

a Mills and a Mitchell. 

Recently selected patients can also be found by clicking on the down arrow 

beside the search box. 

Some additional points about searching are: 

 The search is not case sensitive. 

 Entering in the first few letters of the surname may be sufficient. 

 You may enter patterns: 

o ? stands for any single character (e.g. Jons?n will find Jonson 

and Jonsen) 

o * stands for any group of characters (e.g. St*s will find Sticks 

and Stones) 

Searching by Patient External ID 

You can search by the patient external identifier (the patient index in a 3rd 

party Patient Management system). If these are numeric, then just enter the 

number, eg. 2345. If your 3rd party system uses an alphabetic or 
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alphanumeric index system, then you must precede the identifier with the 

hash “#” character to distinguish the identifier from a name, eg. #DF451. No 

pattern search is available for external IDs. 

Searching a 3rd-party Practice Management 

If a 3rd party practice management is installed the patient search is first 

carried out in the 3rd party database. 

If a unique match is found this will result in pertinent information about the 

patient being read from the 3rd party database into Medmont Studio. The 

information for that patient is either added to Medmont Studio or updated 

(the two databases are synchronised). 

Search Behaviour and the Different Filter Modes 

The exact effect of a search depends on the current filtering: 

 All - The selection jumps to the sought patient (the simple case). 

 One - The selection changes to the sought patient. 

 Filter - If the sought patient is in the filter result, the selection jumps to 

that patient; otherwise filtering reverts to All and the selection then 

jumps to that patient. 

Sorting 

The sort order for both Patient and Exam views can be changed by 

expanding the view to display columns and then clicking on a column 

heading to sort by that criterion (see Figure 32). A second click reverses the 

order of the sort. 

A small arrow in one of the column headings indicates the current sort 

criterion and the direction of the sort (ascending or descending). 

Using the individual column headers to sort the exams belonging to each 

patient does not change the patient list order, only the order of the exams 

belonging to that patient. 

Using Favourites 

The Favourites menu allows you to add a shortcut to frequently accessed 

patients and exams. 
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Figure 41. Organise Favourites dialog. 

Select the item in the Explorer pane and click on Home > Favourites > Add 

to add a shortcut to the item in the Favourites menu. You can optionally 

rename the shortcut to indicate its purpose. The new shortcut is then shown 

under the Home > Favourites > Goto drop down box.  

Clicking Home > Favourites > Organise displays the dialog shown in 

Figure 41. This allows you to change the order of shortcuts by selecting the 

shortcut and using the up or down arrows, or to edit or delete the selected 

shortcut.  

You can jump to a favourite entry by clicking on it in this dialog. The item 

referenced by the shortcut will be displayed in the View pane and selected in 

the Explorer pane.  
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10. The Ribbon Menu 

Medmont Studio uses a tabbed ribbon style interface. The ribbon tabs are 

organized into groups and are labeled according to the function. For 

example, the Home tab contains all functions for creating a new patient or 

exam. All functions have an icon and are labeled, to assist the user with 

identifying functions. 

 

Figure 42. Home Tab. 

The following lists the contents of each tab, and gives a brief summary of 

what each function performs when selected from those tabs. Tabs and 

function will vary depending on which instruments are installed or what 

exam is selected. 

Items that are inappropriate for the current exam(s) or patient(s) appear 

greyed out (disabled), and clicking will have no effect. 

File Menu  

Print - Print a report based on the currently selected patient or exam(s). 

Print Preview - Preview the appearance of a print report. 

Refresh – Forces an update of data from the database. Useful in 

client/server configurations where users on other computers may be 

making simultaneous changes to the database. 

Export - Export a file summarising the currently selected items and 

other information on which they depend. For example, if an exam is 

selected, the essential information about the clinician who conducted 

the exam will be included in the export file. 

Import - Reads in a file created by Export. 

Close - Close Medmont Studio. 
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Home Tab 

Patient 

Find – Search for a particular patient based on their name, birth date, or 

external ID if using 3rd party practice management. 

New - Create a new Patient 

Delete - Permanently delete the currently selected patient(s). 

Note - deleting a patient will also delete all of that 

patient’s exams. 

Exam 

Move To – Copies the selected exam(s) from the current patient to a 

different patient, and removes them from the current patient. Moving 

exams whilst a patient is selected moves all exams belonging to that 

patient to a different patient.  

Copy To – Duplicates, without removing, the selected exam(s) from the 

current patient to a different patient. Copying exams whilst a patient is 

selected copies all exams belonging to that patient to a different patient.  

Delete - Permanently deletes the currently selected exam(s). 

New Exam 

Digital Image – Opens the DV2000 exam window. 

Corneal Topography – Opens the E300 exam type selection dialog. 

Contact Lens – Fit a Contact Lens to an existing E300 exam. 

Perimetry Exam – Opens the M700 exam window. 

External Data 

Synchronize All – Synchronise all existing Medmont Studio patient 

data with an integrated 3rd party Practice Management System 

Synchronize Current – Synchronise the currently selected patient’s 

data with an integrated 3rd party Practice Management System 

Link unlinked – Link a patient in Medmont Studio that is not already 

linked with an integrated 3rd party Practice Management System  

Favourites 

Add – Add a patient or exam to the Favourites list. 
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Organise – Change the order of favourites in the list or add/delete an 

entry. 

Goto – Select a Favourite that has previously been added. 

Links 

Externally linked applications icons are placed here. Export data to 3rd 

party tools, for example contact lens designer tools or email results. 

Configure Tab 

Logon 

Set Password - Change the password of the current user. 

Change User - Switch users without restarting the application. 

Studio 

Practices - Add, modify, import or export associated practice names. 

Clinicians - Add or modify clinicians using Medmont Studio and 

assign or edit their passwords and security access. 

Custom Fields - Define or edit conditions, procedures, categories (of 

exams), and categories (of patients). 

Attributes – Displays the Attributes management dialog.   

Licence – Check, install and update licensing details. 

Session - Check who is logged on and has exclusive access (data locks) 

to particular patients and exams. 

Preferences – Set global preferences for Medmont Studio. 

M700 

Instrument Setup – Opens the M700 instrument setup window, 

allowing you to install, uninstall and test your M700 instrument 

Template Setup – Opens the M700 Template setup window so Test 

Templates, used for M700 exams, can be created, modified, imported 

and exported 

E300 

Instrument Setup – Similar to the M700, this button opens the E300 

instrument setup window, allowing you to install, uninstall and calibrate 

your E300 instrument 
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Calibrate – Calibrate your installed E300 

System Settings – allows you to configure/adjust the Eccentricity, 

Shape Factors, height and Wavefront errors which affects the attribute 

values. 

DV2000 

Image Sources – provides access to the Image Source dialog, allowing 

you to setup an image source to create DV2000 exams. 

Custom Operations – provides access to the Custom Operations dialog 

allowing you to create a custom operation with its own icon. 

View Tab 

The View tab provides buttons to allow you to select the data view to display 

in the View pane.  The available views depend on the item(s) selected in the 

Explorer pane. The available views when a patient is selected are: 

 Details - View and edit personal details and clinical notes. 

 Thumbnail - Shows thumbnail-sized images of all the patient’s 

exams. 

 Regression - Statistical analysis tools. 

For exams, views include a primarily text-based Details view, together with 

a variety of instrument-specific graphic views. 

Display Tab 

Graphical views typically provide a Display tab which contains the 

following common items, in addition to items specific to the view: 

Zoom / Pan 

Controls to zoom and pan the display by clicking the corresponding 

button 

Cursor 

Select – change the cursor for the active view to enable selection of 

annotations and other displayed items 

Pan – change the cursor to allow the active view to be panned by 

clicking and dragging the mouse 



The Ribbon Menu  

 

 

52 Medmont Studio User Manual  
 

Zoom – change the cursor to allow the active view to be zoomed in 

about a selected point by clicking the mouse.   Hold the control key 

down while clicking to zoom out. 

Panes 

Right – select whether the right hand pane (containing attribute values 

and other view specific data) is displayed 

Bottom – select whether the bottom pane (containing comments, cross 

sections and graphs) is displayed 

Annotate Tab 

Provides controls to allow you to add, delete and modify annotations on 

graphic views. 

Selection 

Properties – display (and change) the properties for the selected 

annotation.  You can also use the right click menu or double click on the 

annotation to display properties. 

Delete – delete the selected annotation 

Lock – lock or unlock the selected annotation.   Locked annotations 

cannot be moved or resized.   Locking annotations can be useful to 

prevent them accidently be changed. 

Add Annotation 

Controls to add different types of annotations to the graphic view.   See 

Adding Annotations on page 65 for more detail 

Help Menu 

Links to the various electronic User Manuals and other useful information. 

See Help on page 103 for more details. 

Customizing the Ribbon 

The ribbon has a quick access toolbar (see below) which can be used to store 

a shortcut to a function. The toolbar will become available when a quick 

access shortcut has been added and is located in the title bar.  
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Figure 43. Quick Access Toolbar 

By right-clicking on an icon, you can choose from one of the following 

options: 

Add to Quick Access toolbar – creates a shortcut to the function in the 

Quick Access toolbar. 

Customize the Quick Access toolbar – Opens a dialog box where 

changes can be made to the quick access toolbar. See (Customizing the 

Quick Access toolbar). 

Place Quick Access toolbar below the ribbon –Moves the quick 

access toolbar below the ribbon.  

Minimize the Ribbon – Hides the ribbon, only leaving the tab labels. 

To access functions when the ribbon is minimized, click the required 

tab, which temporarily displays the ribbon containing those functions. 

The ribbon will then minimize once a function has been selected. To 

leave the ribbon on permanently again, double-click on a tab label. 

Customizing the Quick Access toolbar: 

To customize the toolbar, first right-click on an icon and click Customize 

the Quick Access toolbar. Functions are broken down into groups. Select 

the appropriate group from the Choose commands from drop down menu 

and the functions will then appear on left hand side of the divider. Click a 

function and click add. Functions for the quick access toolbar will now 

appear on the right hand side of the divider.  



The Ribbon Menu  

 

 

54 Medmont Studio User Manual  
 

 

Figure 44. Customize the Toolbar 

You can also remove a function from the quick access toolbar by clicking on 

it from the right hand side of the divider and clicking remove. Once all 

changes have been made, click OK. 

Placing the quick access toolbar below the ribbon can also be done from this 

dialog box. Click the box next to Place the quick access toolbar below the 

ribbon and then click OK to enable this option. 
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11. The View Pane 

The View pane is the area to the right of the Explorer pane. It displays 

graphics and information for the patient or exam selected in the Explorer 

pane. 

The exact display depends on the current view mode set using the View 

menu or toolbar. What is displayed depends on the Medmont instrument 

associated with the selected exam, and this is covered in the respective 

instrument manuals. 

Displaying Multiple Views 

When multiple items are selected in the Explorer pane the View pane will 

display (if possible) a separate view for each selected item. 

 

Figure 45. Multiple Views. 

For this to be possible each selected item must have a view mode that 

supports Multiple Views. If more than four items are selected, or one of the 

selected items does not support Multiple Views then no views are displayed.  

The title bar of one view is drawn in a different colour to indicate that this is 

the active view. The menus and toolbars displayed are determined by, and 

relate to, the active view. You can change the active view by clicking on the 

title bar of another view.  

Active view 
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Any of the views can be temporarily made to fill the View pane by clicking 

on the  explode button or double-clicking the view’s title bar. To restore 

the Multiple View display, click on the  implode button or double-click on 

the view’s title bar.  

You can use the zoom and pan controls in this view and the translations will 

apply to all images. The Ctrl-I key for example, will zoom in on all four 

images, and the Ctrl-O will zoom them out. Note that if you have a wheel 

mouse, the wheel allows you to zoom in and out on just the currently active 

view. 

Zooming and Panning 

Using the Menus to Zoom and Pan 

Zooming and panning of graphical views works in a consistent way across 

all Medmont Studio components.  In graphical views you can zoom and pan 

the currently displayed exam using the Display > Zoom/Pan ribbon bar 

group. You can use the Display > Defaults > Reset item to reset the default 

image view. 

When multiple images are displayed zooming and panning of the images is 

synchronised.  

Using the Keyboard to Pan and Zoom 

The keyboard can be a convenient means for zooming and panning. Ctrl-I 

zooms in, Ctrl-O zooms out. Using the arrow keys, Ctrl-left pans left, 

Ctrl-right pans right, Ctrl-up pans up and Ctrl-down pans down. 

Using the Mouse to Pan and Zoom 

You can also use the mouse to pan or zoom within a single image. If the 

mouse is fitted with a wheel, the wheel is always enabled as zoom control. 

You can also change the cursor mode by pressing the spacebar, clicking the 

right mouse button within the image and selecting an option from the popup 

menu or by navigating to the Display > Zoom/Pan ribbon bar group. The 

shape of the cursor will change to reflect the current cursor mode. 

In  Pan mode, click on the image and drag the mouse in the direction you 

wish to move the image. The image will continue to move in that direction 

while the mouse button is down or until a boundary is reached. The speed 

and direction of movement is proportional to the distance of the current 

cursor position from the position when the mouse button was pressed. 
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In  Zoom mode, click on the point in the image that you wish to zoom in 

on. The image will continue to zoom in while the left mouse button is held 

down. If you hold the Ctrl key down while clicking then you zoom out 

instead of in. 
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12. Patient Views 

There are three different views available for Patients described in more detail 

below.   Select a patient in the Explorer pane and then use the View ribbon 

tab to select one of the views.  These views are only displayed when there is 

a single patient selected in the Explorer pane. 

Details View 

 The Details view displays the name, date of birth and sex of the patient 

as well as allowing you to enter some basic clinical data – such as the current 

patient refraction. If Practice Management System Integration (see page 19) 

is installed then this data is updated from the practice management database 

each time the patient is selected based on the External Record that identifies 

the linked patient in the practice management database.  

 

 

Figure 46. Patient Details View. 
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Thumbnail View 

 The Thumbnail view displays a thumbnail image of each exam 

belonging to the selected patient (see Figure 47). 

 

Figure 47. Thumbnail View. 

By default, this view will show a 4x4 grid of the patient’s exams, but this 

configuration can be changed by clicking Configure > Studio > Preference, 

selecting the User Settings tab and clicking on the Review Pane node. Here 

you can make changes to the number of rows and columns shown in the 

thumbnail view.  

If the number of exams for that patient exceeds the number of grid squares 

(e.g. 16 grid squares for a 4x4 grid), a vertical scrollbar will appear, allowing 

you to scroll through the images. 
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Regression View 

 The regression view allows you to see the progress of a patient’s 

results over time.   Figure 48 shows a Regression view for a sample patient. 

The displayed data can be controlled by clicking on Display > Settings > 

Edit.  

 

Figure 48. Regression View. 

The regression view displays plots of data from each of the patient’s exams 

over time.  You can select exactly what data is graphed and displayed.   Any 

exam attribute (see Section 14 Attributes) can be graphed.  There are also a 

number of graph types specific to certain exams types (such as the M700 

histograms displayed above).   The regression settings can be saved in 

named profiles.  The current profile is selected using the drop down selection 

box in the Display > Settings ribbon tab.  There are three profiles defined by 

default – to display data relevant to each supported instrument.  You can 

modify these default profiles (using the  Display > Settings > Edit 

button) or add your own profile (using the  Display > Settings > New 
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button).   You can even display data from different exam types in a single 

profile. 

The Eye ribbon allows you to filter the displayed data by eye.  

If   Both is selected then data from both eyes is displayed on 

the one graph with left eye data being displayed in green and 

right eye data being displayed in blue. 

You can select any data point on the graph and the corresponding exam data 

point will be highlighted on all displayed graphs.  Click the Display > 

Selection > Remove  button to remove the selected exam from all graphs 

(note this just removes the exam from the displayed graph and does not 

delete the actual exam).  The displayed regression line will be automatically 

recalculated for the remaining exams. You can restore the original full set of 

data points at any time by clicking on the Display > Eye > Both  eyes 

button.   

Click Display > Data > Show Exam  button (or double click on a data 

point) to display the exam corresponding to the selected data point in a 

separate window.  Once this window is displayed you can select other data 

points and the exam displayed in the window will track the selected data 

point. 

Zone Filtering 

Some types of graphs (eg 

M700 Histograms) support 

filtering the displayed data 

based on a selected zone of 

the eye.   Clicking one of the Display > Zone buttons will select that zone 

for each of the displayed graphs that support this capability.  If a graph 

supports filtering by zone then the selected zone is displayed in the graph 

title. 

The zone boundaries are shown below in Table 1, where the angular 

coordinate system is anti-clockwise from 3 o’clock (ie 0° is at 3 o’clock, 90° 

is at 12 o’clock). 

Regression Zone Points Included 

Full All points. 

Central Points out to 22° 
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Macula Points out to 10° 

Peripheral Points between 23° and 50° 

Nasal Superior Points between 9° and 23° in the 

upper nasal quadrant 

Nasal Inferior Points between 9° and 23° in the 

lower nasal quadrant 

Temporal Superior Points between 9° and 23° in the 

upper temporal quadrant 

Temporal Inferior Points between 9° and 23° in the 

lower temporal quadrant 

Table 1. Zone definitions. 

Specialized Graphs 

Some exam type’s support specialized graphs (for example M700 Exams 

support histograms as shown in Figure 48).  These specialized graphs are 

described in more detail in the relevant instrument specific manual. 

Trend Lines 

Trend lines are fitted to the mean values for histograms, and to the points 

themselves for single value data points. The default trend line uses the least 

squares method and is based on minimising the sum of the squares of the 

differences between the line and the graphed points. This method works well 

for data that is reasonably distributed and where the data approximates a 

straight line. 

Least squares trend lines are not so effective when the data contains 

significant outliers, as each point has equal weight and the outliers tend to 

skew the regression away from its true position. A more robust median 

regression using M-estimates that minimises the absolute deviation gives 

outliers less weight and in general provides a better fit for highly variable 

data. Median fit is the second regression option (see Regression  below). 
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Regression Settings 

Clicking on Display > Settings > Edit  will display the dialog shown in 

Figure 49. 

 

Figure 49. Regression Settings dialog. 

This dialog allows you to change the settings for the displayed graphs, add 

or delete graphs and select the time period that the regression covers. By 

default the date axis is auto-scaled to include all exams for the selected 

patient. You can also change the order of the graphs using the up and down 

arrows. 

Select an existing graph and click the Edit button or add a new graph using 

the New button.  The dialog shown in Figure 50 is displayed. It allows you to 

change the settings for the selected graph. 

 

Figure 50. Add/Edit Regression Graph. 
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The Graph Attribute drop down allows you to select the attribute or item to 

be graphed.    

The Zone drop down selects the displayed zone (if the graph type supports 

Zone filters).  See Zone Filtering on page 61 for more detail. 

The Trend Line drop down selects the displayed regression trend line 

(None, Point to Point, Least Squares, Median Fit).   See Trend Lines on page 

62 for more detail.  

If the Auto Scale Values option is checked then the graph Y values are 

automatically calculated to include all the displayed data points.  If the 

option is not checked then the Min Value and Max Value numeric boxes are 

enabled and allow you to manually set the Max and Min Y values for the 

graph.  The Set Minimum Range option allows you to specify a Min and 

Max value in conjunction with Auto Scaling.  In this case the Min and Max 

values specify the minimum range of Y values that the graph will display.   

This prevents the Y axes collapsing to a very small range when there are 

only a few data points or the data points all have the same value.   If data 

points lie outside the minimum range the Y axes is still automatically scaled 

to ensure the points are visible. 
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13. Annotations 

Annotations can be added to exams using the options on the Annotate tab. 

Annotations are stored with the exam and may be printed, exported and 

imported. Display of annotations can be turned off for the current view, by 

deselecting Display > Options > Annotations. 

Annotations can even be added to a comparison view of two exams. In this 

case the annotation is stored and the next time the same two exams are 

compared the annotation is displayed.  

Adding Annotations 

Click on the desired tool from the Annotate tab. Move the mouse to the 

active view pane and the mouse cursor will change to reflect the type of 

shape being drawn.  

Text Annotations 

The  Text tool changes the cursor to allow you to place a text annotation 

on the image. Click at the location that you want the anchor for the 

annotation to be placed. The Text Annotation dialog (see Figure 51) is then 

displayed, allowing you to enter the text. 

 

Figure 51. Text Annotation Dialog. 

Callout Annotations 

The  Callout tool changes the cursor to allow you to place a text callout 

annotation on the exam. This consists of a text label and line pointing to the 
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selected anchor location. Again a dialog is displayed to allow you to enter 

the text for the annotation. 

Ruler Annotations 

The  Ruler tool allows you to make a measurement between two points 

on the exam.    The units of measurement depend on the exam. 

Shape Annotations 

The Annotate tab provides tools for adding different shape annotations to 

the active view: 

 Circle – create circle annotations. 

 Ellipse – create ellipse annotations. 

 Rectangle – create rectangle annotations 

 Square – create square annotations. 

 Polygon – create polygon area annotations. 

 Curved – create curved area annotations. 

 Freehand – create freehand area annotations. 

Click on the desired shape tool from the Annotate tab. Move the mouse to 

the active view pane, the mouse cursor changes to reflect the type of shape 

being drawn. 

As their names imply, the Circle, Ellipse, Rectangle and Square annotation 

tools allow you to create these shapes. To create one, click at the point where 

you want to place the shape and drag the mouse to complete the drawing. 

You can create three types of area annotations. To draw Curved or Polygon 

areas click on the first point and keep clicking until the second-last last 

point. Right click to complete the curve. To draw a Freehand area, click on 

the first point and drag the mouse around the required shape, and stop 

dragging when you are finished. 

Shapes can always be fine-tuned by resizing or moving. To move or resize a 

shape annotation, click anywhere on the shape to select it. Small, circular hot 

spots will be displayed on the shape. Click and drag the desired hot spot to 

move a particular point. To move the whole shape, click and drag from either 

any point on the shape (except a hotspot), or from the centre cross hair. 
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Editing Annotations 

To edit an existing annotation double click on the annotation and the editor 

will be displayed allowing you to change the text or attributes. Selecting a 

Text or Callout annotation displays the Edit Annotations dialog shown in 

Figure 51, allowing you to change the text and colours. Selecting a Shape 

Annotation displays the Edit Shape Annotation dialog shown in Figure 52. 

 

Figure 52. Edit Shape Annotation. 

This dialog allows you to choose the colour, style and line width of the 

shape. You can also add a callout to the shape that allows you to associate 

text with the shape. The Callout box allows you to select the option that 

controls the visibility of any text associated with the shape. Select the Show 

always or Show if selected entry to enable the Callout Settings… button, 

and then click on this to display the text annotation dialog (see Figure 51) to 

edit the text and display properties. 

Locking Annotations 

Once an annotation has been created it can be locked, meaning that it cannot 

be altered or repositioned until it is unlocked. This is to avoid accidently 

moving or otherwise altering an annotation while left clicking on the exam 

data to view critical readout data or otherwise navigate around the image 

data. 

Once you have selected the annotation, you can change the status of the 

locking mechanism in 2 ways: 

1. Directly on the annotation itself - Right click to bring up the annotation 

menu and select Lock to toggle the current status of the lock. 
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2. From the menu – Select Annotate > Selection > Lock to toggle the 

current status of the lock. 

The locked status of an annotation is indicated by the presence of a small 

lock symbol  attached to the annotation as shown in Figure 53. 

 

Figure 53 Square Annotation showing the lock symbol. 

Deleting Annotations 

To delete an annotation, select the annotation (by clicking once on it), click 

on Annotate > Selection > Delete. 

Saving and Undoing Changes 

Changes and additions you make while working with an exam are not saved 

immediately. You will notice that as soon as you add an annotation, two 

buttons will become active on the Data pane for the active view,   Save 

and Undo. You can use these buttons to save the changes you have made 

or to undo any changes since the last save operation. If you haven’t saved 

changes manually the system will automatically display a dialog to prompt 

you to save changes when you change the selected item(s) in the Explorer 

pane.  
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14. Attributes 

Attributes are calculated values that apply to a particular type of exam result. 

They may be a physical measurement or dimension, or they could be a 

number that is the result of applying some statistical based calculation.  

Medmont predefine a large set of standard attributes for each instrument. 

You can modify these predefined attributes or use the underlying exam data 

to create new attributes.  Click Configure > Studio > Attributes to display 

the Attributes dialog (Figure 54).   Each Exam Type has its own set of 

attributes – select the Exam Type using the selection box. 

 

Figure 54. Attributes dialog. 

To edit an existing attribute, select the attribute in the list and click the Edit 

button. 

To add a new attribute click the New button and select the type of attribute 

from the drop down.  There are four basic types of attributes: 

 Calculated Attributes 

 Annotation Attributes 

 Entered Attributes; and 

 Code Blocks 

These are described in more detail below. 
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Calculated Attributes 

Calculated attributes calculate a simple value, using a mathematical 

expression, based on other attribute values or predefined data functions that 

are specific to the exam type. The mathematical expression is a simple 

Visual Basic statement that returns a simple numeric value. The attribute 

expressions for each exam type are compiled into code that is used to 

evaluate attribute values for each exam. 

Click the New > Calculated Attribute button to display the dialog shown in 

Figure 55.    

 

Figure 55. New Calculated Attribute Dialog 

The Calculated Attribute dialog fields are described below. 

Name 

The name is used to identify the attribute within the compiled Visual Basic 

code and so must be a valid Visual Basic identifier containing only 

alphanumeric characters.   



 Attributes 

 

 

 Medmont Studio User Manual 71 
 

Display Name 

This is the name of the attribute displayed in the data pane for the exam.  

The software will automatically generate a Display Name for you based on 

the Name you type (replacing underscores with spaces) – however you can 

change the Display Name to make it more readable.   

Units 

The units displayed in the data pane for this attribute  

Decimal Places and Scientific Format 

These controls allow you to specify how the displayed attribute values are 

formatted. 

Classify Function 

This allows you to specify a function that classifies the resulting attribute 

value as Normal, Suspect or Abnormal and colour codes the display 

accordingly (see Classifier Functions on page 72 for more detail).  In this 

example the predefined ClassifyAbove function is used to specify that values 

above 42 are to be classified as suspect and values above 44 as abnormal.  

Expression 

This is the Visual Basic statement that generates the attribute value. It must 

be a valid Visual Basic (single line) statement that evaluates to a numeric 

value.  The statement can call Data Functions that are defined for the Exam 

Type. The Data Functions tab displays the available functions and the 

parameters that the function expects.  Double click on a Data Function to 

paste it into the Expression text box – then replace the parameter 

placeholders with the values to pass to the function.   The expression can 

also reference other attributes already defined for the Exam Type. The 

Attributes tab displays the existing attributes and allows you to paste them 

into the expression in a similar way.   The example shown in Figure 55 uses 

an existing attribute (Flat_Angle) and passes this to the predefined 

AxialPower Data Function to calculate the average power at an 8mm chord.   

The buttons under the expression show common Visual Basic mathematical 

operators and clicking on them pastes the operator into the Expression text 

box. 
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Annotation Attributes 

Annotation attributes allow you to define named annotations that when 

added to an exam by a user generate attribute values related to the properties 

of the annotation (eg width, height, area etc).  Use the New > Annotation 

with Attributes button to add a new annotation attribute of the selected type. 

 

Figure 56. New Annotation with Attributes Dialog 

Name 

The name is used to identify the attribute within the compiled Visual Basic 

code and so must be a valid Visual Basic identifier containing only 

alphanumeric characters.   

Display Name 

This is the name of the attribute displayed in the data pane for the exam.  

The software will automatically generate a Display Name for you based on 

the Name you type (replacing underscores with spaces) – however you can 

change the Display Name to make it more readable.   

Icon 

You can specify a custom icon that will be used to represent this attribute in 

the Annotate > Add Attribute ribbon group. 
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Attributes 

Each annotation type has its own set of predefined attributes that are 

generated automatically when the attribute annotation is added to an exam.  

Circle annotation attributes (as in the example above) define attributes for 

the radius, area, circumference and centre of the circle.  These attributes can 

be displayed in the data pane (eg Tumour Border: Area) or referenced by 

other attributes.  You can change the formatting, units and classification of 

these generated attributes by double clicking on the attribute or selecting the 

attribute and clicking the Edit Attribute button  

Default Annotation Properties 

Click the Color/Font button to specify the default properties of the 

annotation that is created when the user selects the custom annotation 

attribute from the Annotate > Add Attribute ribbon group. 

Entered Attributes 

Entered attributes allow the user to manually enter a value that will be 

associated with an exam.  This value can be referenced by other attributes 

and used for filtering the displayed data. 

 

 

Figure 57. New Entered Attributes Dialog 

Name 

The name is used to identify the attribute within the compiled Visual Basic 

code and so must be a valid Visual Basic identifier containing only 

alphanumeric characters.   
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Display Name 

This is the name of the attribute displayed in the data pane for the exam.  

The software will automatically generate a Display Name for you based on 

the Name you type (replacing underscores with spaces) – however you can 

change the Display Name to make it more readable.   

Max/Min Value 

These are the maximum and minimum allowed values for the attribute – 

values outside these values cannot be entered. 

Default Value 

Entered attributes are not defined until the user clicks on the attribute (shown 

in italics) in the data pane.  When the user clicks on the attribute the value is 

set to the Default Value and the user can then change this with the up/down 

arrows or by typing.   The value can be reset to its original undefined value 

by right clicking.   

Units 

The units displayed in the data pane for this attribute.  

Decimal Places and Scientific Format 

These controls allow you to specify how the displayed attribute values are 

formatted. 

Classify Function 

This allows you to specify a function that classifies the resulting attribute 

value as Normal, Suspect or Abnormal and colour codes the display 

accordingly (see Classifier Functions on page 72 for more detail).   

Code Blocks 

Code blocks allow you to define your own Visual Basic functions and 

constants that you can then call from Calculated Attributes.  This can be 

useful if you need a more complex expression that cannot be evaluated in a 

single line of code.  Click the New > Code Block button to create a new 

code block. 
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Figure 58. New Code Block Dialog 

Name 

The name is used to identify the code block – but is not compiled, so it may 

contain non-alphanumeric characters.   

Code 

The code text box is used to enter the function definition. You can define 

multiple functions in a single code block and may also declare constants and 

properties.  Code block functions may call any of the predefined data 

functions or reference other attribute values. In this example we have 

defined a new AvgAxialPower function that computes the average axial 

power around a given half chord by iterating over the angle (from 1 to 360 

degrees) and calling the predefined AxialPower data function.  Note that that 

the predefined data function returns the Double.NaN (Not a Number) value 

if there is no data at the specified point – so the function checks for this and 

ignores these values if present. 
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Once you have defined the code block with your new function you can then 

use this function from within a Calculated Attribute. In this case you could 

define a Calculated Attribute with the expression AvgAxialPower(4.0) to 

display the average half chord of 4mm.  

Classifier Functions 

Classifier functions allow you to specify a function to be called to determine 

the classification of the attribute value.   Classifier functions are typically 

passed the attribute Value and return one of three classifications: 

 Normal – displayed as green in the data pane 

 Suspect – displayed as orange in the data pane 

 Abnormal – displayed as red in the data pane 

There are three predefined classifier functions: 

 ClassifyAbove– takes the attribute value and two threshold values.   

Values above the thresholds are classified as Suspect and Abnormal 

respectively 

 ClassifyBelow – takes the attribute value and two threshold values.   

Values below the thresholds are classified as Suspect and Abnormal 

respectively 

 ClassifyBetween – takes the attribute value and four threshold 

values.   Values above and below the thresholds are classified as 

Suspect and Abnormal respectively. 

It is also possible to define your own classifier function using a Code Block 

to implement more complex classification schemes. 

Displaying Attributes 

You can select the attributes to be displayed in the Data pane by clicking on 

the   Arrange user defined attributes button.  This displays the dialog 

shown in Figure 59. The Available column on the left is the list of available 

attributes, while the Selected column on the right is the list of those 

attributes selected for display. You can move any or all from one side to the 

other using the arrow keys in the centre. The single arrows will move a 

selected attribute from the Available list to the Selected list, or remove it 

from the Selected list. The double arrows will copy the entire Available list 

to the Selected list, or completely clear the Selected list. 
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Figure 59. Arrange Attributes dialog 

The up and down arrows on the right allow for changing the order in which 

the selected attributes are displayed. The top item will be the first attribute 

displayed. Selecting an attribute in the Selected list and then clicking on the 

up arrow will move that attribute towards the top of the list. Clicking on the 

Sort button will sort the column alphabetically. 

If the Show Undefined Attributes checkbox is selected then attributes are 

displayed even if they are not defined for the current exam.  If, for instance 

an annotation attribute has not been defined by the user for the exam then the 

attribute values corresponding to it will not be displayed in the Data pane 

unless this option is selected.   If this option is selected then these attributes 

are always displayed (in italics if they are not defined). 

Note that the displayed attributes are saved as part of the windows user 

settings and so can be different for each windows user.  You can use the 

Configure > Studio > Preferences menu to reset these user settings to their 

original default values. 

Recalculating Attributes 

Normally Medmont Studio will automatically recalculate the displayed 

attribute values for an exam whenever required (for instance if you move or 

resize an annotation attribute then all of the values that depend on it will be 

automatically recalculated).  Sometimes however you may need to manually 

force the attributes for an exam to be recalculated.  If new attributes have 

been created or existing attributes changed since an exam was evaluated then 

the attribute values for that exam may be out of date.  The  Recalculate 
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Attributes button on the Data pane allows you to force the attributes for the 

current exam to be recalculated.  You can force the attributes for all exams of 

a given type to be recalculated by clicking the Evaluate All button in the 

Attributes dialog (see Figure 54) 
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15. Printing 

The Print Dialog 

The File > Print and File > Print Preview menu items bring up a list of 

reports pertinent to the current selection.  

 

Figure 60. The Print dialog. 

Select a report format from the list and click OK to Print or Print Preview the 

report. 

Print Settings 

Clicking the Settings button in this dialog brings up another that allows you 

to customize the report by changing the General settings (see Figure 61). 

 

Figure 61. Print Settings dialog. 
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For some reports, typically exams, additional options are available from a 

second tab. An M700 exam for example, would name the second tab an 

Overview Print, and selecting this tab would display the dialog in Figure 62. 

 

Figure 62. M700 Threshold exam Overview Print dialog. 

The New button enables you to name a customized report format and retain 

it for future use.  

Print Preview 

The File > Print Preview option brings up a similar dialog to File > Print, 

but clicking OK now shows a preview window containing a precise version 

of what the report would look like on paper. 

Note that what is printed for a given view is not necessarily the current 

display in the View pane, depending on the Print settings.  

 

The preview window provides the following options for working with the 

preview: 
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Report – Select the type of report to print. 

Settings - Change the settings for this report. 

Print - Prints the report. 

Clipboard - Save the preview image to the clipboard. 

File - Save the preview image to a file. Supported file formats are: 

i. Windows bitmap - .bmp 

ii. Graphics-interchange-format - .gif 

iii. JPEG - .jpg 

One Page – Show only one page of the report 

Two Pages – Show two pages of the report (if applicable) 

Four Pages – Show four pages of the report (if applicable) 

Six Pages – Show six pages of the report (if applicable) 

Page – Change the currently displayed page of the report (if one 

page is only shown). 

Whole Page – Adjust the current view so the entire page is shown 

Page Width – Adjust the current view so the width of the page fits 

across the screen. 

200% - Zoom the current page of the report to 200% 

150% - Zoom the current page of the report to 150% 

100% - Zoom the current page of the report to 100% 

50% - Zoom the current page of the report to 50% 
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16. Usage Hints 

This section provides some hints for making the most of Medmont Studio. 

Auto-Capitalisation 

Some text entry boxes in Medmont Studio allow you to specify automatic 

formatting options such as Auto Case. This means that if you type 

“john citizen”, it will automatically be translated to “John Citizen” as you 

type. However, this is not what you want if you are entering a name like 

“McDonald”, so you can change this option with a right mouse click. 

For example, if you are entering a Procedure called “Cataract & IOL 

Surgery” into the custom Fields dialog, you will need to turn off auto-case so 

the “IOL” is not entered as “Iol”. Right-clicking on the Name text box will 

popup a menu (see Figure 63) that allows you to select from the following 

options: 

uSer cAse There is no automatic case control. Only the 

keyboard Shift key controls case. 

Auto Case The leading character of any single word will be 

capitalised. 

UPPER 

CASE 

All characters entered will be converted to upper 

case, regardless of the keyboard Shift key. 

lower case All characters entered will be converted to lower 

case, regardless of the keyboard Shift key. 
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Figure 63. Right mouse click for Case entry control. 

The dialog will remember these settings. Thus if you have selected uSer 

cAse to enter a new patient name like “MacDonald”, the next time you enter 

a new patient the setting will still be uSer cAse.  

Tabbing between Fields 

When entering data in dialogs, you can navigate between data fields using 

the Tab key. This is often more efficient then swapping continually between 

using the mouse and keyboard. Tab moves the focus to the next field. Shift-

Tab moves the focus to the previous field. 

Default Buttons 

Many displays and dialogs support default buttons. This is the button with a 

darker shadow around it, like the OK button shown here. 

 

You can activate the default button at any time by just pressing the Enter key. 

When combined with the use of Tab, these keys provide a very efficient 

mechanism for entering data. 
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Entering Dates 

Many dialogs use the Microsoft Date control for entering dates. This control 

lets you enter dates in a variety of ways. Choose the one that suits your 

needs best: 

Numeric / Arrow Key Entry  

1. Select the date control. The day is highlighted.  

2. Type in the day using the numeric keypad.  

3. Press the spacebar, “/” key, “–” key, or right arrow key to move to the 

month. You can change the month using the up/down arrow keys. 

4. Move to the year. You can enter a 4-digit value or change the year using 

the up/down arrow keys. 

Graphic Calendar Selection  

1. Select the down arrow next to the date control.  

2. A small calendar is displayed.  

3. Click on the year and use the up/down arrow keys to select the year.  

4. Click on the month to select the month from a drop down list, or click 

on the left/right arrow keys. 

5. Select the day on the displayed calendar. 

Today’s date can be quickly selected by clicking on “Today” at the bottom 

of the calendar. 
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17. Utilities 

Medmont Studio Configuration Tool 

The Configuration tool allows you to re-configure Medmont Studio without 

requiring a new installation. Run this tool if, for example, you have 

purchased a new instrument, selecting it in the Select Instruments section of 

the configuration wizard: 

 

Figure 64. Configuration Tool  

As another example, if it was necessary to move the Medmont Studio 

database to a different folder on another disk or even onto another computer, 

use this tool to manage the transfer. Ensure Medmont Studio is not running 

then move through the Configuration dialogs until the data location entry 

appears. Note the current location, as you will need this later. 
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Figure 65. Moving a Database 

Ensure the new data directory exists. Click on the Location button and 

navigate to the new folder. Click on OK and then click Next to advance 

through to finish the configuration. This step will have reconfigured 

Medmont Studio to now use the new folder, but it has not moved the data. 

You will need to use Windows Explorer or similar to actually copy the data 

from the old to the new location. Remember to copy all the source sub-

folders too. 
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RSS News Reader 

Medmont Studio incorporates an RSS news reader to display up-to-date 

company announcements. In order for this feature to operate correctly, the 

computer must have a working internet connection. When connected to the 

internet, the software will query the Medmont internet server and alert the 

user to any new company announcements. 

 

Figure 66. RSS News Reader 

To display the RSS news reader at any time, select the Help > Latest News 

menu item (located on the far right of the ribbon bar menu). From within the 

news reader, click the desired link to view the full article. The RSS news 

reader may be disabled or enabled at any time by clicking on Configure > 

Studio > Preferences to display the preferences dialog. From the User 

Settings tab select Startup in the preferences tree and add or remove the tick 

next to the Check News At Startup option. 
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18. Licensing 

Medmont Studio uses an online licensing scheme which limits access to only 

licensed software modules called components.  A special alpha-numeric code 

called an Activation Key is required to activate components of Medmont 

Studio. The Activation Key is then locked to the computer and the lock is 

sent to Medmont via the internet, this process shall be referred to as 

“Authenticating your license”. If the computer does not have an active 

internet connection a license file can be sent via email or other electronic 

medium. Components can be licensed indefinitely or for a set time period. 

In the absence of a valid Activation Key or if your component licenses have 

expired, Medmont Studio will function in Single User Review Mode.  

Installing a Medmont Studio license. 

The first step required to license Medmont Studio is to install the software 

onto a computer. If the software is not yet installed please follow the 

installation instructions in the section titled Installing the Software. 

All licensing tasks are performed from the License Manager.  To start the 

licensing process, open the License Manager by clicking the Configure > 

Studio > License button as per Figure 67. 

 

Figure 67. Opening the License Manager 

The License Manager window should now be displayed. An example of the 

License Manager window is displayed in Figure 68. 
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Figure 68. License Manger Window with no license installed. 

Click on the Install button. The Install License window should now be 

displayed as per Figure 69. 

 

Figure 69. Install License window 

Installing a license on a computer with internet access. 

If your computer has a working internet connection enter the Activation Key 

which was provided with your instrument into the field marked License Key 

as per Figure 70 and click the Install button.  

 

Figure 70. Install License window with Activation Key 

The Install License window should now contain the phrase “License 

Installed” in the License Status field as per Figure 71. If any other message 

appears in this field please contact your local Medmont support agent for 

support.  
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Figure 71. Install License window with valid license installed. 

The license process is now complete. Click Close to display a list of active 

components. Verify you have been assigned the correct licenses. If you 

believe an error has been made with your license please feel free to contact 

the agent who supplied you with the instrument for support. 

Installing a license on a computer without internet access 

If your computer does not have a working internet connection enter the 

Activation Key which was provided with your instrument into the field 

marked License Key as per Figure 70 and click the Install button.  

After a brief pause the message in Figure 72 will be displayed.  

 

Figure 72. Warning message displayed if no internet connection is available. 

Click No if you would like to repair your internet connection and try again. 

Click Yes if you would like to save the license to a file.  By choosing to save 
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to a file you then have the option of either emailing the file to Medmont or 

transferring it to a computer with a working internet connection and 

authenticating it via a web browser. 

Authenticating via a web browser 

If you would prefer to authenticate your license right away then you can 

authenticate your license file via a web page available online. Transfer your 

license file onto a computer with a working internet connection. A USB flash 

drive is ideal for this task. 

From the online computer open a web browser and enter the following web 

address into the address bar. We recommend using Internet Explorer 9 or 

higher. 

http://www.medmont.com/authenticate/AuthenticateFile.aspx 

The following web page in Figure 73 should now be displayed. 

 

Figure 73. Authentication web page. 

Click on the Browse button and select the License file saved earlier. Click 

the Authenticate button. Continue to save the authenticated license file to 

the local computer as per Figure 74. 

http://www.medmont.com/authenticate/AuthenticateFile.aspx
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Figure 74. Authenticated license file save prompt. 

Click Save to write the file on the local hard drive as per Figure 75. 

 

Figure 75. Authentication file download complete. 

Click the Open folder button to locate the authenticated license file called 

AuthenticatedLicense.lic. Transfer the authenticated license file back to the 

original computer. From the Install License window press the Load License 

button as per Figure 76 

 

Figure 76. Install License window showing location of Load License button. 
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The Load License file window should now be displayed. Navigate to the 

AuthenticatedLicense.lic file and click Open. The license should now be 

installed. The text License Installed should be displayed in the License 

Status field as per Figure 77. 

 

Figure 77. Install License Window with license installed successfully. 

Click Close. The Medmont Studio License Manager should now display a 

list of components activated by your license as per Figure 78. 

 

Figure 78. License Manager Window with list of active components. 

Authenticating via email. 

If you would prefer to have Medmont handle the authentication of your 

license then you will need to email the license file to your local Medmont 

representative. 

You can close the License Manager while you wait for a response from your 

local distributor. After receiving a reply email, transfer the attached 

AuthenticatedLicense.lic file back to the computer where Medmont Studio 

will be installed.  

 

There could be up to 3-4 business days before a 

response is received. If you do not receive an email 

response within this timeframe please check your 

Junk or Spam email box to see if the return email 

has been marked as junk. If it cannot be found here 
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then contact your local authorized Medmont 

distributor for help. 

Next you will need to import the authenticated license back into License 

Manager. Open License Manager by clicking Configure > Studio > License 

from the main menu. When the License Manager window appears click on 

the Install button which will display the license entry window. Press the 

Load License button as per Figure 79 

 

Figure 79. License Entry Window with Load License button highlighted. 

You will now be prompted for the authenticated license file which was 

attached to the email response from Medmont. Specify the location of this 

file and click Open. 

The authenticated license should now be installed. The License Manager 

Window will now display a list of components which have been activated by 

your license as per Figure 80. 

 

Figure 80. License Manager Window with list of installed components 

highlighted. 

Updating an existing License 
 

If you have already licensed your software and you decide to purchase 

additional components you can easily update your license. The update license 
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process requires a working internet connection. If you do not have a working 

internet connection you will need to re-license your software using your original 

Activation Key as per the section Installing a Medmont Studio license.  

 

To update your license open the License Manager window by clicking on the 

Configure > Studio > License button on the main ribbon bar. Once open you 

can press the Update button to update the license as shown in Figure 81. 

 

 

Figure 81. License Manager with highlighted update license button. 

After a short delay and provided the update process completes without error the 

following message shall be displayed. 

 

 
 

If any other message is displayed please check your internet connection and try 

again otherwise contact your local authorised distributor for support. 

Frequently Asked Questions (FAQ). 

How do I transfer my license to another computer? 

If you need to transfer your license from one computer to another and the 

computer where the license is currently installed has an internet connection 

then you can simply uninstall the software using the Programs and Features 

applet in Control Panel. During the uninstallation you will be asked to 

deactivate the license, choose yes. This will release the lock on the license so 
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that it can be re-installed on another computer. If the licensed computer does 

not have an internet connection then you will need to contact your local 

authorized distributor to release the lock for you. 

What should I do if I cannot find my Activation Key? 

If you cannot find your original Activation Key then Medmont can provide 

you with your key for a small administrative fee.  

What’s the best way to contact Medmont for license related questions? 

Medmont uses a global network of distributors to handle local support issues 

like licensing. Please contact your local authorized Medmont distributor. In 

most cases this will be the company that sold you the instrument originally 

but since distributors do change from time to time you can find the contact 

details of your local distributor from the following web page 

http://www.medmont.com/contact 

I already own a fabulous E300 Corneal Topographer from Medmont 

and I want to buy their equally amazing M700 Automated Perimeter. 

Can I get a license which combines both instruments? 

At the time of purchasing your instrument a sales representative should ask 

you if you already own any other Medmont instruments. If you do then we 

can update your license to include the new instrument. Once Medmont has 

updated your license and provided you have a working internet connection 

on the computer with the installed license you can update your license using 

the Update license function in License Manager. To update a license on a 

computer without a working internet connection please follow the step in 

section Installing a license on a computer without internet access. 

The laptop I use with a licensed version of Medmont Studio was stolen. 

Can I get a replacement license? 

Yes. Please contact a Medmont authorized distributor who will remove the 

lock on your license so it can be re-used on another computer. 

Session Licenses 

Sessions are important for network configurations. In these, each active 

Medmont Studio application running on a client computer needs the server 

computer to supply it with a session. The maximum number of sessions 

allowed is controlled by the license and is encoded in the activation key. 

This means that licenses can float between computers. The server will assign 

up to the maximum number of sessions to client machines, so there may be 

http://www.medmont.com/contact
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more client computers than sessions as long as at any one time there are only 

the given number of clients actively using Medmont Studio. 

In normal use each time the Medmont Studio software is started on a client 

computer, the server assigns a license to that client. When the application 

exits the license is returned to the server pool and becomes available for 

another client. 

Once a license has been assigned to a client that client gains all functionality 

available under the license. 

For example, a local-area network with ten computers attached could run 

Medmont Studio on all of the computers at different times, but if the 

maximum number of sessions is five, then no more than five computers can 

run Medmont Studio simultaneously. A sixth user trying to start Medmont 

Studio will get a Not Enough Sessions error message. 

If this happens, the user could ask another user to exit, thereby freeing up a 

license. If this happens often, you may wish to purchase licensing for 

additional sessions from Medmont. 

Extraordinary conditions that could result in the client software ceasing to 

operate include an administrator logging off a user or the server software 

shutting down. 
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19. Data Backup 

It is in your own interests to regularly perform backups to avoid loss of data 

due to hardware failure or accidental deletion or corruption of the database. 

If you have been using a 3rd party Practice Management system, it will have 

its own database files, and it is likely you will have already established a 

regular backup procedure. If so, then simply add the Medmont database 

location (see Backup Locations on page 99) to the list of folders you are 

already backing up. 

However, if you are just at the planning stage of a backup policy, Medmont 

suggests that all the various practice databases be regularly backed up to 

media that can be taken off-site. This could be a laptop computer that is 

plugged into the practice network, a CD-ROM or DVD, or a USB disk. 

Backup Media 

The choice of backup media will depend somewhat on the size of your 

practice, the instruments you are using, and the number and type of exams 

your practice does in a given period. But no matter how small your practice, 

the days of using floppy disks for backup are long gone. A medium sized 

practice that includes imagery as a service can easily require several 

gigabytes of backup storage. 

Backing up to a laptop is convenient in that you can just connect it to the 

practice network, navigate to the various Medmont and Practice 

Management data folders, and use Windows Explorer to copy the files. The 

feasibility of this method depends on first having a laptop with a large 

enough disk, having plug-in access to the network, and your confidence in 

the long-term reliability of the laptop. 

USB disks in early 2007 came in sizes up to 4 gigabytes, and this would be 

adequate for most practices. The amount of storage available on these 

devices will only get bigger, so with the same caveat about long-term 

reliability, this could be a satisfactory backup solution. 

Backup to a CD-ROM burner is a more reliable option, in that the CD is 

essentially a permanent system snapshot. However, if you are using 

instruments that produce imagery such as the Medmont E300, it will not be 

long before your overall database size exceeds the around 700 megabytes 

available on a single CD. In comparison, the hardware costs and procedures 
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to backup to a DVD burner are now no different to a CD-ROM, with the 

advantage of nearly seven times the backup space. 

With all this in mind, Medmont recommend using a DVD burner as your 

backup medium, either mounted in the server computer or capable of being 

plugged into its USB2 port. 

The next decision is the backup software. Unlike Windows 2000, Windows 

XP and subsequent versions like Vista provide for direct transfer from the 

various database storage locations to a DVD using Explorer. However this 

means manually navigating to the various directories to backup each 

individual database for the products your practice uses. Windows provides a 

backup program appropriately called Backup on the Windows distribution 

CD, and if installed it is available from 

Start > Programs > Accessories > System Tools. This has facilities that 

allow you to pre-program the integration of selected files and folders from a 

number of locations into a single backup file, along with how it should be 

stored and to where (an adequate solution if you are backing up to another 

computer or a laptop). However the program knows nothing about CD-

ROMs or DVDs. 

The requirement is therefore for backup software that offers facilities to pre-

specify the locations and folders that require backup (i.e. it will remember 

the various locations between backup sessions), and the ability to copy to a 

CD-ROM or DVD burner. In addition, it should have the ability to span the 

backup file across multiple disks for when the size of the backup exceeds the 

media capabilities. 

Medmont recommended you survey the market yourself for backup software 

that meets these requirements. 

Backup Locations 

The Medmont Studio 6 database is by default stored in an all users 

accessible data folder called Data. In a default installation this will be: 

%allusersprofile%\Medmont\Medmont Studio 6\Data. 

On Windows 7 this path resolves to: 

C:\ProgramData\Medmont\Medmont Studio 6\Data 

Do not confuse this Data directory with the data directory 

belonging to an earlier Version 3 Medmont Studio that was 

usually located at C:\Program Files\Medmont\Data. 
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At installation this folder can be assigned to any computer in the practice 

network, to any disk on that computer, and to any folder path on that disk. 

However, clicking on Start > Medmont > Medmont Studio Administrator 

Tool will display the dialog in Figure 82, and this will list the database 

location in the Data Location field. 

 

Figure 82. System Administrator Tool. 

Initiating a Backup 

No matter what Medmont configuration you have installed, all copies of 

Medmont Studio must be stopped before initiating a backup. For a stand-

alone system this is easy, but for a server system you will need to stop the 

Medmont server using the Server Manager. 
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Figure 83. Medmont Studio Server Manager. 

The Server Manager icon  will be present in the desktop tray of the 

network server computer. Double click on this icon to display the Studio 

Server Manager dialog shown in Figure 83. The Active Sessions entry will 

show if any clients are running Medmont Studio. Click the Refresh button 

to recheck the number of active connections to the server. If connections are 

still active you can use the following options to disconnect them. 

1. Find the machine(s) currently running Medmont Studio to ensure no 

one is using it, shut it down, and then come back and click the Stop 

Medmont Studio Server button, or 

2. Click the Stop Medmont Studio Server button. 

The effect of clicking this button on connected clients is to disconnect them 

from the server with no mechanism to reconnect other than re-starting, so the 

second option has the potential for data loss if the computer is currently in 

use. Avoiding this situation is a company procedures issue, where either a 

certain time is set-aside for backup or it happens after hours. 

The more usual effect of stopping the server is, of course, to prevent clients 

starting Medmont Studio. If they try they will see the message shown in 

Figure 84 and Studio will refuse to start. 
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Figure 84. Error message for when no server is available. 

Once the server is stopped you can proceed with your backup procedure. If 

necessary, click the Compact and Repair button on the Administrator tool 

(see Figure 82) for occasional database management.  
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20. Help 

The Help menu provides access to the User Manuals for Studio and the 

installed instruments. These are in PDF format and therefore require the 

installation of a PDF reader such as Adobe Acrobat or similar. Adobe reader 

is freely available on the Internet at http://get.adobe.com/reader/. 

The individual manuals include a bookmark page organised as a directly 

accessible table of contents that indexes the main section headings. Press F6 

to show the bookmarks page or click on the sidebar. Clicking on an entry 

will navigate to the corresponding page.  

Also directly accessible are the internal links within each document such as 

the italicised chapter headings, page numbers, Figures and Tables. Move the 

mouse cursor over any of these links and the cursor will change to a pointer. 

Clicking on any of these will move the displayed page to the reference. Use 

the Previous View button on the Acrobat toolbar to return to the original 

page. 
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